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OVERVIEW

1.1. ABOUT THIS USER GUIDE
This User Guide has been produced by the Primary Health Care Research and Information Service (PHC RIS) to guide you through the stages of producing your Agreement Plan, Annual Plan, Six-Monthly Progress Report and Annual Report. It also provides instructions on how to submit these plans and reports to your State and Territory Office (S/TO) for approval, and to PHC RIS when required. 

Additional information and further support related to the topics covered in this guide can be found in the PHC RIS website: http://www.phcris.org.au
1.2. DEVELOPMENT OF THE PLANNING AND REPORTING PRO FORMA

In response to the recommendations from the review of the Divisions Network, the Australian Government Department of Health and Ageing (DoHA), in consultation with the Business Management Advisory Group (BMAG), developed a new planning framework that was trialled by three Divisions for their 2004-07 Agreement Plan and 2004-05 Annual Plan. The areas covered in the BMAG planning framework built on the existing Outcomes Based Funding (OBF) Template planning and reporting framework for Divisions. The most significant difference between the two frameworks was the move away from goals to defined priorities. Priority areas were identified by the Department. Piloting Divisions did not find major difficulties adapting to the BMAG framework for their 2004/5 planning.

The Review Implementation Committee (RIC), in a meeting on 3 November 2004
, agreed on a model for the implementation of a new planning and reporting framework for the Divisions network, as an integral component of the National Quality and Performance System (NQPS)
. A Planning and Reporting working group (PRWG), led by the PHC RIS, was formed to develop a draft structure and content of the planning and reporting document(s) to be used by Division Network members as part of this new planning and reporting system. The working group consisted of members from the Divisions network, previous BMAG participants, State and Territory Office and Central Office (CO) DoHA representatives and PHC RIS staff
. The final content and structure was built on their experience of what works for them and how they do things.

Both the cost of planning and reporting processes and the value of the information collected, disseminated and analysed need to be balanced when implementing an effective and efficient planning and reporting system for the Division Network members. Issues addressed when designing the content of the new planning and reporting document(s), and defining the processes for approval, collection, dissemination and analysis were: 

· Identification of relevant and sufficient data

· Data quality assurance 

· Avoiding duplication of reported data 

· Future integration of the Annual Survey of Divisions into the new reporting structure

· Streamlining the requirements of the various funding bodies and other stakeholders

1.3. PLANNING AND REPORTING INFORMATION FOR THE DIVISIONS NETWORK AND ITS STAKEHOLDERS

The new Planning and Reporting pro forma was developed to address the needs of the Divisions Network and DoHA as primary stakeholders, and others that have an interest in the Divisions Network as secondary stakeholders. The requirements of each stakeholder group are stated in the following table. 

	
	Organisations
	Requirements for Planning and Reporting system

	Primary Stakeholders
	Divisions
	· Comply with contractual obligations to DoHA to plan and report on activities performed with DoHA funds. These could include sharing of information for benefit of Divisions Network and others.

· Meet Divisions internal requirements for staff and Board.

	
	The Department: Funding body
	· Contract management with individual members of network.

· Accountability for Divisions Program.

· Information for input into health policies and initiatives 

· Information to assist evaluation of program outcomes to inform government considerations of future funding for the Divisions network.



	Secondary Stakeholders
	Health community with interest in Divisions Network  
	· Accessible searchable information about activities and achievements of the Divisions network. 

· Assessment of results of the Divisions network. 


The pro forma is an information collection tool developed with flexibility in mind. It allows adaptability for DoHA and for Divisions’ internal use, while making the processing of information easy for contract management and assessment. The tool will also allow the collection and public display of information by an independent organisation. 

A draft pro forma was widely circulated to the primary stakeholder groups, and its final design incorporates the feedback received. This Planning and Reporting pro forma replaces the OBF Template which was previously used for Divisions of General Practice to enter their Strategic Plans, Business Plans, and 12 Monthly Reports.

Completing your Agreement Plan, Annual Plan, Six-Monthly Progress Report and Annual Report in the Planning and Reporting pro forma is a DoHA requirement.

Those Divisions with a current approved Agreement Plan will need to incorporate that plan into this pro forma in order to complete their Annual Plan 2005-06 and subsequent plans and reports. 

The current version of this pro forma is a non-automated document developed using MS Word®. PHC RIS will be working on the development of an automated version of the document that will facilitate data extraction and incorporate validity checks. You can use this version to produce your Agreement Plan and Annual Plan 2005-2006. The transport of data from one system to another will not require work from your Division.

2. PREPARING YOUR PLANS

The three-year Agreement Plan should outline, for each National Priority Area, the domain areas within which the Division will focus its objectives, and the strategies it will use to achieve them.  Divisions need to provide their Agreement Plan to DoHA for approval. This plan will be considered in the context of the National Quality and Performance System for the Divisions Network. In order to prepare your Agreement Plan you must take the following steps:

PRIORITY AREAS

In the Government response to the Divisions review, the following seven National Priority Areas (NPAs) for primary care were identified: 

· ACCESS: Improve access

· INTEGRATION: Encourage integration and multi-disciplinary care

· PREVENTION AND EARLY INTERVENTION: Focus on prevention and early intervention

· CHRONIC DISEASE MANAGEMENT: Better manage chronic conditions

· GENERAL PRACTICE SUPPORT: Support GPs and general practices within a changing primary care environment

· QUALITY SUPPORT: Support quality and evidence base

· CONSUMER FOCUS: Ensure a growing consumer focus

At its 4 August 2004 meeting, the RIC agreed that GOVERNANCE, i.e. organisational capacity, eg financial accountability and governance, and WORKFORCE, i.e. supporting the recruitment and retention of an appropriate primary care workforce, were also priorities for Divisions.

The Divisions Planning and Reporting framework is based on these nine national priority areas. All work performed by your Division and funded by DoHA must relate to at least one of the National Priority Areas.

DOMAINS

Consider the domains in which your Division will focus in each of the nine national priority areas, as follows:

· There are nine national domains identified by DoHA in five of the national priority areas (Table 1)

· Your Division must plan to work in these national domains in the areas of access, integration, prevention and early intervention, and governance. In the CDM area, your Division must choose to work in at least one of the three nationally identified domains. 

· It is compulsory for Divisions funded under the More Allied Health Services Program (MAHS) to include the MAHS domain in the access NPA. It is also compulsory for Divisions funded by the Workforce Support for Rural GPs (WSRGP) Program to include a WSRGP domain in the General Practice Support NPA.

· Your Division is encouraged to identify additional local domains to plan for and work in each of the national priority areas for which national domains are identified. 

· This first implementation phase of the National Quality Performance System does not identify national domains in the areas of GP support (except WSRGP for Divisions funded by this program), quality support, consumer focus and workforce. During this first year, your Division must determine at least one local domain to plan for in each of these four areas. 

· There is no limit to the number of domains your Division includes in its plan.

Table 1.- National Priority Areas and Domains

	National Priority Area
	National Domain
	Local Domain(s)

	
	Name
	Compulsory
	

	Governance
	Performance Improvement Culture
	Yes
	Desirable

	
	Effective External Engagement
	Yes
	Desirable

	
	Financial Compliance and Risk Management
	Yes
	Desirable

	Prevention and Early Intervention
	Immunisation
	Yes
	Desirable

	Access
	Residential Aged Care
	Yes
	Desirable

	
	
	
	MAHS (compulsory if funded)

	Integration
	GPs and Hospitals
	Yes
	Desirable

	Manage Chronic Disease (CDM)
	Asthma
	At least one 
	Desirable

	
	Diabetes
	
	

	
	Mental Health
	
	

	General Practice Support
	--

--
	
	Compulsory

	
	
	
	WSRGP (compulsory if funded)

	Quality Support
	--
	
	Compulsory

	Consumer Focus
	--
	
	Compulsory

	Workforce 
	--
	
	Compulsory


OBJECTIVES

Determine and define the objectives of your Division in each of the NPAs, in relation to the national domains and your locally defined ones, as follows:

· Each of the nationally defined domains currently has at least one national objective. These objectives must be included in your plan. In the case of the CDM domain, select the national objective for the domain(s) your Division will focus on.  The Residential Aged Care domain includes the objectives of the Aged Care GP Panels Initiative.

· Within each one of the national domains, you may plan additional related local objectives, defined by your Division. 

· MAHS domains have three identified objectives that must be included in your plan if your Division is funded under this Program. WSRGP domain has two identified objectives that your Division must include in its plan if funded under this Program. Your Divisions is encouraged to incorporate additional local objectives in these domains.

· For those locally defined domains, your Division must establish at least one local objective. 

· There is no limit to the number of objectives for each NPA.

STRATEGIC APPROACHES 

Plan the strategies that your Division will put in place for the achievement of each one of your objectives. Your Division context needs to be taken into account at the time of deciding the best strategies to be used in each case.

You may wish to use the following categories, which some Divisions have found useful in grouping their strategic approaches: 

1) Practice systems development and support 

2) GP professional development 

3) GP staff professional development 

4) Joint CPD including other stakeholders 

5) GP health system integration - primary care 

6) GP health system integration - hospital care 

7) Public education / health promotion 

8) Other

Although your strategies are part of your three-year Agreement Plan, they may be modified during the funding period. You can review and adapt them according to your Division’s requirements at the end of each reporting period in preparation for the following Annual Plan. 

PERFORMANCE INDICATORS

As part of your Annual Plan, you will determine the level at which your Division plans to measure its performance toward each particular objective, as follows:

· National objectives have a set of national performance indicators (NPIs) defined by DoHA. These NPIs are classified in four levels in accordance with the National Quality Performance System for the Divisions Network
. Some of the NPIs are compulsory for all Divisions, and you must select those in your plan. All other NPIs are optional. You may choose any combination of the optional indicators according to the level you think your Division will be performing during the planned period. 

· The national performance indicators will be implemented with a point system.  This has been developed as a means to increase transparency and provide clear expectations.   Points have been allocated for reporting against a NPI and an organisation has a minimum number of total points to aim to achieve in 2005-06.  Divisions should aim to achieve a minimum of 84 points. This minimum score for 2005-06 is the sum of the compulsory indicators.  However, you can report on as many additional NPIs as you wish.  

· In 2006-07 the minimum points total will be raised.  The raised total will be comprised of the compulsory points plus additional points that you will be able to achieve by self selecting additional NPIs to respond to.  Again, you will be able to report on as many additional indicators as you wish.   

· Divisions must nominate a primary CDM domain –diabetes, mental health or asthma- and report against each of the compulsory indicators within that CDM domain.  Should you choose to report against one or two additional chronic disease domains, you are not required to report on all the compulsory NPIs in those additional domains.  

· Bonus points will be linked to performance indicator targets as they are established in 2007-08.  The current allocation of bonus points is indicative only and will be reviewed when these targets are set in consultation with the network.     

· When you determine each of your Division local objectives, you will need to define a set of local performance indicators to measure their achievement at the end of the planned period. These indicators are local indicators, and can be set at any of the four levels contemplated by the National Quality Performance System. 

Your Division needs to select the national performance indicators that it plans to work on during the year indicating the associated points you are claiming against these indicators, as part of your Annual Plan.  

KEY ACTIVITIES

The Annual Plan should outline the annual activities and operations that the Division will undertake in order to achieve each one of its objectives.  

Your Division needs to provide its Agreement Plan and Annual Plan to DoHA for approval.  Modifications thereafter to your plans need to be notified and sent to your S/TO.

3. PREPARING YOUR REPORTS

Using this Planning and Reporting pro forma, Divisions are required to provide reporting information of two kinds: 

1) the complete results on the Performance Indicators selected, and 

2) a reflection on the work performed toward each objective. 

It is important that you provide accurate details of your Division’s context in your reports. This will complete the information necessary to consider your Division’s performance, and to inform future decisions, all understood as part of a continuous quality improvement process. 

RESULTS ON THE PERFORMANCE INDICATORS SELECTED FOR EACH OBJECTIVE:

National performance indicators are technically defined to be reported in a specific manner. The results of these indicators can be classified in four categories according to their format:

· YES/NO result

· Qualitative statement containing “aims”, “actions taken” and “outcomes” 

· Results table 

· Qualitative statement to fill in with results

For each indicator your Division selected at the planning stage, you will have to report according to its technical specifications
. An explanatory text column is provided in the pro forma for all indicators to allow your Division to add information to aid interpretation of your results, eg information about specific circumstances in your Division or catchment area.

REFLECTION ON WORK PERFORMED TOWARD EACH OBJECTIVE

This section is intended to allow Divisions to record their experiences and conclusions for their own self reflection processes as well as to share for the benefit of the Network. This information must also cover the reporting requirements from the funding agreements.

Your report should include, for each objective, the following qualitative information: 

Notable achievements and key contributing factors: 

Describe the major achievements towards each objective, and the key factors contributing to these achievements.  Include any conclusions the Division has made as to why these elements were successful.  You may provide an assessment of local conditions - environmental factors, socioeconomic factors, community capacity, health behaviours and person related factors - that contributed to the success.

Notable challenges and key contributing factors:

Describe those key factors that became barriers to the successful achievement of your objective, if any. You may describe those elements of your strategies that did not meet your expectations and inhibited progress in this objective, including any conclusions the Division has made as to why these elements were unsuccessful. 

What did the Division learn from the strategic approaches used?

Based on this year’s experience, describe how your Division will approach this objective next year.

How were community needs met?

One of the aims of the DGPP is to meet community primary health care needs.  Describe why the Division identified this objective as one of community need and how it has contributed to these.  Include reference to the evidence base that supports this objective in meeting the identified community need.

Recommendations
Include any recommendations from your Division to members of the Divisions Network, DoHA or other bodies, to improve performance in relation to this objective.

4. HOW THIS ALL FITS TOGETHER IN YOUR PRO FORMA

	NATIONAL PRIORITY AREA

	National Domains
	Local Domains

	National Objectives
	Related Local Objectives
	Local Objectives

	Strategies
	Strategies
	Strategies

	Activities
	National Performance Indicators
	Activities
	Local Performance Indicators
	Activities
	Local Performance Indicators

	National Performance Indicators Results
	Performance Indicators Results
	Performance Indicators Results

	Reflection on work
	Reflection on work
	Reflection on work
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MAHS AND WSRGP Standard Data Items (SDIs) will be collected through the Annual Survey of Divisions in 2005 and then integrated in this pro forma along with the ASD for the Annual Report 2005-2006. ACGP Panels SDIs will be collected with the OBF Template Reports in 2005 and then integrated in this pro forma subsequently.

WORKING WITH THE PLANNING AND REPORTING PRO FORMA

The Planning and Reporting pro forma is a single “living” document system designed to incorporate your Agreement Plan 2005/08, Annual Plan 2005/06, Six-Monthly Report and Annual Report 2006. Within your organisation you can use it to design your plans and reports in an easy and flexible manner, as it has been created using the commonly used Microsoft® Word. Once each of these plans and reports is finalised, you will submit it to your S/TO for approval on the due date, according to your contractual obligations. On approval of the Annual Report this will be also sent to PHC RIS for collation and dissemination of information through an on-line searchable database. 

The pro forma is structured as follows:

Title Page

1.- Division’s Contact Details

2.- Division’s Context

3- Planning and Reporting Information by Priority Area

3.1. GOVERNANCE

3.2. PREVENTION AND EARLY INTERVENTION

3.3. ACCESS

3.4. INTEGRATION

3.5. MANAGE CHRONIC DISEASE  (CDM)

3.6. GENERAL PRACTICE SUPPORT

3.7. QUALITY SUPPORT

3.8. CONSUMER FOCUS

3.9. WORKFORCE

4: Result Tables for Performance Indicators Reporting

Tips for managing your pro forma 

1. Keep a copy of the original pro forma in your computer. 

2. When you open the pro forma for the first time, use the Save As option in the File menu to give the pro forma a name that identifies your working document, eg Agreement Plan 2005/08.

3. Always back-up your pro forma. You may use again the Save As option to include date information, eg. Draft Agreement Plan 2005_03_15

4. Ensure that ‘Save AutoRecover info’ is activated. To do this, go to Tools in the main menu -> Options and select the Save tab.

5. Keep a copy of the pro forma for your records after approval from your S/TO

6. If your pro forma is saved on the shared drive make sure that you have named it clearly so all staff know which version to work on.

TITLE PAGE

Enter the required title for the version of the document you are preparing, eg Agreement Plan 2005-2008 or Annual Plan 2005-2006 in the front page.

A Document History table is provided for you to keep a record of the various submission stages the document has covered along the planning and reporting cycle. This table is for internal use and you can modify it according to your own requirements.

DIVISION CONTACT INFORMATION

Enter the Division name, Division legal name (if different), ABN, Division number, street address(es), postal address, phone, fax, email, website address, Division legal status, and the name of the person(s) with authority to sign on behalf of the Division.

An organisation chart can be inserted, if desired, in any of the formats that MS Word® accepts, eg plain text, table, graph, image, hyperlink. 

DIVISION CONTEXT

No single Division is the same as another. Divisions understand the issues they face which may not be obvious from statistics. This section provides an opportunity for Divisions to describe briefly their understanding of key characteristics of their area, what these mean in terms of primary health care needs, and what directions the Division is taking to meet these needs. This information will help readers to understand the particular context of each Division’s plan of action, report and performance information.  Each section does not need to be any longer than ½ a page. 

A brief profile of General Practice in the Division catchment (Please include key matters relevant to your Division. These may include adequacy and sustainability of the local workforce; areas of growth; distance or matters relating to other health services.) You do not need to include detailed general practice data for your Division (eg number of GPs, members, practices) as these will be collected as part of the Annual Survey of Divisions in 2005. 

A brief profile of the Division population and its health needs (Please include key matters relevant to your Division such as demographic trends, population dispersal, the Aboriginal and Torres Strait Islander population and other socially and culturally diverse groups.) Your Division may have access to large amounts of detailed demographic information such as Census data, which you interpret using your local knowledge (of matters such as temporary influx of people due to tourism or seasonal work). Please use this section to identify the most relevant matters from your perspective. 

Key issues for the Division in relation to primary health care needs and delivery (refer to the demographic and social characteristics of the Division population and the profile of the general practice workforce.) There will be many more needs and issues in your Division area than the Division can address. Please use this section to identify the key issues for the Division.  

Key issues for this Division in relation to integration with hospital based services (Include issues relevant to access, transport, communication, information exchange, and coordination.) Divisions vary greatly in their relationship with hospitals, with differences in type, number and size of hospitals per Division in urban, rural and remote areas. Indicate the most relevant issues for your Division. 

Key directions for the Division in engaging General Practice at the local level (Include the directions your Division has decided on to meet needs identified in the profile of general practice, such as workforce recruitment and retention; maintaining or improving the level of engagement with practices, general practitioners and other practice workforce; practice support.) Engaging GPs and General Practice is essential for Division success in implementing any program.  

Local strategic directions in relation to the national priority areas (Specify how your local priorities address the key issues you have identified above as well as the health needs of Aboriginal and Torres Strait Islanders and other socially diverse groups.) Use this section to indicate where your local issues fit into the broad national priority areas. 
Division Accreditation status eg accredited (please state with which organisation), registered for accreditation (please state with which organisation); not registered for accreditation.  Indicate your accreditation status at the time of planning, with the name of the accreditation organisation if relevant. 
PLANNING AND REPORTING INFORMATION

Each National Priority Area has a separate section in the pro forma that can be identified by the section header.  The section is then structured by objectives, so that each objective is contained in one page (this will expand as information is entered). The “objective page” has four tables that will contain its planning and reporting information, as shown in Figure 1. This structure applies to all objectives, national and local.
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Figure 1
National Objectives

The pro forma already contains the pages needed for the planning and reporting of all national objectives. Their tables contain the domain, description, and rationale for each national objective, as well as all its pertaining performance indicators. 

Except in the national priority area of CDM, you should not remove national objectives pages. In the area of CDM, you may remove the pages for domains which you are not going to address. Other national objectives are compulsory and you should not remove them. 

Local Objectives

Pages for at least one local objective in each priority area are also included in the pro forma. For those Divisions that receive funding from the MAHS and/or WSRGP programs, a page has been included in the pro forma for at least one objective for these domains. These pages may be removed if not applicable to your Division. The tables for all local objectives, initially empty, are to be completed by your Division according to the definitions provided in the Glossary of Terms and guided by the Planning and Reporting framework. 

Should your Division plan additional local objectives, you will need to insert a page with the four tables for each additional objective, as follows:

· Locate in your document a page for a local objective as originally provided (See Figure 1). If you have already populated all the tables provided, you may find this in your saved original pro forma. 

· Select the empty four tables and copy them using the standard Copy function of MS Word®.

· Locate the section corresponding to the priority area where your new objective belongs to. You may identify the section by looking at the page header. 

· Place the cursor just after the last table of the last objective in that priority area and use the MS Word® Paste function. 

You may use similar procedures to rearrange the order in which your objectives appear in each priority area. However, we ask you to leave national objectives before your local ones to simplify processing by your S/TOs and others. 

If your Division does not plan any local objectives in an area where national objectives are defined, you may delete the pages corresponding to those local objectives using the standard MS Word® Delete function. This will reduce the length of the document and remove “white noise”.

Strategic Approaches And Key Activities

To finalise your Agreement Plan, input the strategic approaches you have chosen to address each of your objectives in the corresponding table.

 Follow with the Annual Plan by describing the key activities you will use to implement those strategies. 

Performance Indicators

Complete your Annual Plan by selecting the performance indicators that your Division plans to work on during the year. 

· From the tables that are already completed with national performance indicators, delete unselected indicators from the table by removing the corresponding row, using the Table->Delete->Rows from the MS Word® menu. 

· For your local objectives, insert a new row for each indicator by using Table->Insert->Row Below from the MS Word® menu. Input the level and description for your new indicator. You may wish to complement the description of your local indicators by providing their technical specifications in an attached document.

Reporting Results and Reflection on Work

At the reporting stage your Division will need to complete the remaining items in each table, as well as any relevant performance indicator result tables in the Performance Indicators Result Tables section of the pro forma.

5. FORMATTING YOUR PRO FORMA

Unlike reporting in the OBF Template, text inserted in this document can be formatted using MS Word® formatting features. Nevertheless, it would be appreciated if you maintain the formatting provided as the information contained in this version will need to be transferred by PHC RIS to an automated version of the pro forma with embedded controls that will enable data extraction. 

Please note that the section and table structures are not to be modified at all. 
It is essential that you maintain the existing structure to allow information processing.

6. SUBMITTING YOUR PLANS AND REPORTS

SUBMITTING YOUR AGREEMENT PLAN, ANNUAL PLAN, SIX-MONTHLY PROGRESS REPORT AND/OR ANNUAL REPORT TO YOUR STATE AND TERRITORY OFFICE FOR APPROVAL

Once the Planning and Reporting pro forma is complete with your plan and/or report, you must submit a copy to your S/TO for approval. This should be accompanied by the financial budget/report using the relevant pro formas.  Please consult with your S/TO about submission requirements and preferences:

For an electronic version of your plan or report: 

Step 1. Create an email

Step 2. Enter the email address of your S/TO

Step 3. Give your email a “subject” that identifies the document you send, eg Division# Agreement Plan 2005/2008 pro forma

Step 4. Attach your pro forma

Step 5. Send email

For a hard-copy version, print the complete document using the Print function of MS Word and post it to your S/TO.

SUBMITTING YOUR APPROVED ANNUAL REPORT TO PHC RIS 

Once your Annual Report has been approved by DOHA, follow the below steps to send it to PHC RIS for inclusion in an On-line Searchable Database

Step 6. Create an email

Step 7. Address the email to template.phcris@flinders.edu.au
Step 8. Give your email a “subject” that identifies the document you send, eg Division# Annual Report 2005/2006 pro forma

Step 9. Attach your pro forma which has the approved Report

Step 10. Send email

GLOSSARY OF TERMS

National Priority Area – In April 2004 the Australian Government identified seven priorities to strengthen primary care. The challenges, examples and plans for the future are outlined for each area in Government Response to the Report of the review of the role of Divisions of General Practice ,April 2004 p 3 
 The Review Implementation Committee added a further two areas of workforce and consumer response (RIC communiqué September 2004 
)- Return
Domain 

Each national priority area is very broad. The domain describes a particular issue within a broad topic area. There can be multiple domains within a priority area. For example, mental health, diabetes and asthma are domains within chronic disease management. Immunisation is a domain within prevention and early intervention. 

National Domains The initial set of performance indicators for the 2005-2006 year cover nine domains within some of the priority areas. 

Local Domain – Divisions are to use the local domain section to identify particular local issues they have selected as priorities. For example, they may select Indigenous health care as a domain in the Access area, or workforce recruitment and retention as a domain in the Workforce area, or links with community based services in the Integration area. Two domains have been defined to  accommodate existing DoHA funded programs: More Allied Health Services, and Workforce Support for Rural General Practitioners. 
Objective

(What you expect to achieve, what you wish to make different.) The specific intended impact or result of your Program within the 3-year Funding Agreement period. 

National Objective - Defined by DoHA. Each national objective has a similar structure. It includes the approach Divisions will take to achieve the particular purpose in a specified population group or setting. For example, Divisions will [work with relevant hospitals] (the approach) to [improve local service planning and integration of care] (the purpose) for [patients, families and communities.] (the population) - Return
Related Local Objective – – Local objective in a National Domain, which is therefore related to a National objective.,- Return
Local Objective – Objective defined by your Division in a local domain.  For example, To increase access of Aboriginal and Torres Strait Islanders to culturally appropriate primary health care in collaboration with the local Aboriginal Controlled Community Health Service. - Return
Rationale – Explanation of the fundamental reason for the objective. Justification.

Performance Indicator (How do you know you are making progress?) A particular characteristic or dimension used to measure intended changes. Performance indicators are used to observe progress and to measure actual results.  Performance indicators serve to answer "how" or "whether" progression is being made towards its objective, rather than “why” such progress is or is not being made.
National Performance indicators have been developed through the Review Implementation Committee work plan as part of the National Quality Performance Framework. 

Local indicators are developed by a Division to indicate progress towards a local objective. Return

Strategy

(How you are going to achieve your objectives?) The broad approaches you are going to use to achieve your stated objective during the 3-year agreement planning period. 
Activity

(What you are going to do.) The specific tasks and/or processes involved in implementing your strategy in your annual plan. 
DO YOU NEED HELP?

The following are some important contact details and useful web links for using your Planning and Reporting pro forma.

If you require technical advice or support, please contact the PHC RIS Help Desk by:

Email: helpdesk.phcris@flinders.edu.au
Phone: 1800 025 882

If you require content advice or support, contact your state or territory office of DoHA;

Email: 

Phone: 

You may also consider contacting your State Based Organisations for content advice and support, particularly for State, regional and local issues related to your plans and reports.

If you would like to access on-line support material in matters related to the Planning and Reporting Framework, visit the PHC RIS Website on http://www.phcris.org.au 
FEEDBACK REQUEST

PHC RIS welcomes your comments and feedback on the Planning and Reporting pro forma, this User Guide and the on-line support material developed for this project. A formal process to obtain your feedback on the useability of this pro forma will occur in May 2005, before the pro forma is automated.   Please contact the PHC RIS Help Desk on helpdesk.phcris@flinders.edu.au or 1800 025 882.

APPENDIX 1

Members of the Planning and Reporting Working Group (in alphabetical order)

Don Allan



Adelaide Central and Western Divisions of General Practice 

Kylie Burton 


Department of Health and Ageing (Divisions, Development)

Brenton Chappell

Adelaide Hills Division of General Practice

Kylie Dixon



Primary Health Care Research and Information Service

Colin Gould


Primary Health Care Research and Information Service

Libby Kalucy


Primary Health Care Research and Information Service

Ann Maree Liddy


Queensland Divisions of GP 

Belinda Lunnay


Primary Health Care Research and Information Service

Carmen Navarro-Sanchez 
Primary Health Care Research and Information Service (Chair)

Kleo Pope



SA State Office, Department of Health and Ageing 

Tricia Rawlison


HKR Division of General Practice

Carolyn Searle 


North West Melbourne Division of General Practice 
Bev Sibthorpe 


Australian Primary Health Care Research Institute

Susan Webster 


General Practice Divisions Victoria

Valerie Williams


SA Divisions of GP Inc 

Acronyms

	BMAG
	Business Management Advisory Group

	CDM
	Chronic Disease Management

	DOHA
	Australian Government Department of Health and Ageing

	GP(s)
	General Practitioner(s)

	MAHS
	More Allied Health Services

	NPA
	National Priority Area

	NPI
	National Performance Indicator

	NQPS
	National Quality and Performance System

	OBF
	Outcome Based Funding

	PHC RIS
	Primary Health Care Research and Information Service

	PRWG
	Planning and Reporting Working Group

	RIC
	Review Implementation Committee

	S/TO
	State and Territory Offices of the Department of Health and Ageing

	SBO
	State Based Organisation

	WSRGP
	Workforce Support for Rural General Practitioners 


�� HYPERLINK "http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ricm031104comm.htm" ��http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ricm031104comm.htm�


�� HYPERLINK "http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ric_nat_perf.htm" ��http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ric_nat_perf.htm�


� Members of the Working group are listed in Appendix 1.


� http://�HYPERLINK "http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ricinfo.htm/$FILE/ricm170904.pdf"��www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ric_nat_perf.htm�


� Technical Details for National Performance Indicators for Divisions of GP 


�� HYPERLINK "http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-index.htm/$FILE/fut_dir.pdf" ��http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-index.htm/$FILE/fut_dir.pdf�


� http://�HYPERLINK "http://www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ricinfo.htm/$FILE/ricm170904.pdf"��www.health.gov.au/internet/wcms/Publishing.nsf/Content/health-pcd-programs-divisions-ricinfo.htm/$FILE/ricm170904.pdf�
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